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Sehr geehrter Kunde,

zunächst möchten wir Ihnen zum Erwerb Ihres Gerätes gratulieren.

Bitte lesen Sie die folgenden Anschluss- und Anwendungshinweise sorgfältig durch und befolgen Sie diese 
um möglichen technischen Schäden vorzubeugen.

Warnung
•	 Das Gerät enthält Teile, die dem Benutzer nicht zugänglich sind. Reparaturen dürfen nur von qualifizier-

ten Fachkräften durchgeführt werden.
•	 Die Gerätekennzeichnung befindet sich auf der Unterseite des Geräts.
•	 Setzen Sie das Gerät nicht Tropf- oder Spritzwasser aus. Stellen Sie auch keine mit Flüssigkeiten gefüll-

ten Gefäße, wie Vasen, darauf ab.
•	 Benutzen Sie das Gerät nicht in der Nähe von Badewannen, Waschbecken, Küchenspülen, Waschtrö-

gen, auf nassen Untergründen, in der Nähe von Swimmingpools und auch nicht an Orten, an denen es 
nass ist oder eine hohe Luftfeuchtigkeit herrscht.

•	 Lassen Sie keine Gegenstände auf dieses Gerät fallen und lassen Sie das Gerät nicht fallen.
•	 Stellen Sie keine schweren Gegenstände auf dieses Gerät.
•	 Setzen Sie Batterien nicht direkter Sonneneinstrahlung, Feuer oder ähnlichem aus.
•	 Benutzen Sie nur Zubehör und Anbauteile, die vom Hersteller zugelassen sind.
•	 Eine Reparatur ist dann erforderlich, wenn das Gerät auf irgendeine Weise beschädigt wurde, das heißt 

wenn Flüssigkeiten darauf ausgelaufen sind, Gegenstände darauf gefallen sind, das Gerät Regen oder 
Feuchtigkeit ausgesetzt wurde, wenn es nicht ordnungsgemäß funktioniert oder fallengelassen wurde. 
Versuchen Sie nicht das Gerät selbst zu reparieren. Durch Öffnen der Abdeckung verfällt die Garantie.

Transport
Bitte bewahren Sie die Originalverpackung auf. Um einen ausreichenden Schutz beim Transport des Gerä-
tes zu erreichen, verpacken Sie das Gerät in der Originalverpackung.

Reinigung
Verwenden Sie keine flüchtigen Flüssigkeiten, wie Insektensprays. Durch zu starken Druck beim Abwischen 
können die Oberflächen beschädigt werden. Gummi- oder Plastikteile sollten nicht über einen längeren 
Zeitraum mit dem Gerät in Kontakt sein. Nutzen Sie ein trockenes Tuch.

Kleine Objekte/Verpackungsteile 
Bewahren Sie kleine Objekte (z.B. Schrauben und anderes Montagematerial, Speicherkarten) und Verpa-
ckungsteile außerhalb der Reichweite von Kindern auf, damit sie nicht von diesen verschluckt werden kön-
nen. Lassen Sie kleine Kinder nicht mit Folie spielen. Es besteht Erstickungsgefahr!
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Bedienelemente
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Display 1 7
PRESET
Sender als Favorit speichern (gedrückt hal-
ten) bzw. aufrufen (kurz drücken)

VOLUME / SELECT
Drehen, um Lautstärke zu verändern;

drücken, um aktuelle Auswahl zu bestätigen
2 8 LEFT

Zum vorigen Menü / Sender

Lautsprecher 3 9 RIGHT
Ins nächste Menü / nächster Sender

ON/OFF 4 10 Kopfhöreranschluss

LOCAL
Lokale Sender suchen 5 11 Line-Ausgang

MENU
Menü aufrufen 6 12 DC-Stromanschluss

Fernbedienung: Schalten Sie das Gerät ein, legen Sie die Batterien in die Fernbedienung ein und halten die 
Fernbedienung in Richtung IR Sensor auf der Front der Gerätes.  Der Abstand zwischen Fernbedienung und 
Gerät sollte 7m nicht überschreiten

Power Standby / Einschalten

Mute Stummschalten

0 - 9 Zifferntasten für Speicherbelegung (1-99) 
(Buchstaben und Symbole siehe Anhang A)

Zum Hauptmenü

Mode Zwischen Internetradio und Mediencenter-
Funktionen wechseln

Alarm Alarmzeiten für 2 Alarme einstellen

FAV+: Aktuellen Sender zu Favoriten hinzufügen

 + (1-99) Sender aufrufen (Preset mit Zifferntaste wählen)

Local Im Internetradiomodus lokalen Sender suchen

Info Senderinformationen

      Pfeiltasten zur Navigation

Enter Aktuelle Auswahl bestätigen

  Voriger / nächster Sender/Titel

VOL + / - Lautstärke ändern

Sleep Sleep-Timer
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Erste Inbetriebnahme / Einstellungen
Folgen Sie diesen Schritten, um das Radio mit Ihrem W-LAN Netzwerk zu verbinden.

•	 Schalten Sie das Radio ein: Stecken Sie das Stromkabel des Netzgerätes in den DC-Stromanschluss 
auf der Rückseite des Gerätes und schalten dann das Gerät ein.
Achtung: Verwenden Sie nur das mitgelieferte Netzgerät. Ein Netzgerät mit abweichenden Span-
nungswerten kann das Gerät beschädigen und Sie gefährden.

•	 Die Anzeige schaltet sich ein und es wird nacheinander folgen-
des angezeigt:

 

•	 Wählen Sie mit Rad oder Pfeiltasten YES zum Einstellen des 
Netzwerks:

•	 Wählen Sie ADD/REMOVE AP und im Untermenü ADD AP (AP = Access Point = Ihr W-Lan-Router) 

Die Umgebung wird nach verfügbaren APs gescannt und schließlich wird eine Liste angezeigt. Wählen 
Sie aus dieser Ihren W-LAN-Router und drücken Sie SELECT zum Verbinden.

•	 Sie werden im letzten Schritt zur Eingabe Ihres Router-/W-LAN-Passworts aufgefordert. Geben Sie 
dieses mithilfe von VOLUME/SELECT oder dem Ziffernbereich der Fernbedienung ein (wenn das Pass-
wort nur aus Ziffern besteht)
Achtung: Die Passworteingabe ist „case sensitive“  - bitte beachten Sie die Groß-/Kleinschreibung. 

•	 Nach erfolgreichem Verbindungsaufbau zeigt das Display:

 Add/Remove AP 

AP:[  ] 

 Add AP 

Remove AP 

 
Association complete 
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Das Gerät zeigt den Verbindungsaufbau generell mit dem Symbol  in der linken oberen Display-Ecke an. 
Bei bestehender Verbindung erscheint an gleicher Stelle die Anzeige der Verbindungsqualität:  .

Hauptmenü und Funktionen

Drücken Sie MENU am Gerät oder  auf der Fernbedienung, um das Hauptmenü anzuzeigen. Das Haupt-
menü erscheint mit den Punkten Meine Favoriten, Internet Radio, Media Center, Wecker, Sleep Timer, Einstellun-
gen. Blättern Sie jeweils mit dem SELECT-Rad (drehen) und wählen Sie aus (drücken).

Meine Favoriten

•	 Drücken Sie  auf der Fernbedienung oder halten Sie PRESET am Gerät gadrückt, um den aktu-
ellen Sender als Favorit zu speichern. Der neu hinzugefügte Sender wird jeweils unten an die Liste 
angefügt.

•	 Drücken Sie  oder PRESET (kurz), um die Liste aufzurufen. Scrollen Sie mit den Pfeiltasten oder 
geben Sie die Indexnummer des gewünschten Senders per Ziffernfeld auf der Fernbedienung ein. 
Drücken Sie SELECT zum Aufrufen des markierten Senders.

•	 Drücken Sie RIGHT oder  (Fernbedienung), während ein Sender in der Liste markiert ist, um das 
Optionen-Menü aufzurufen. Hier haben Sie die Möglichkeit, den jeweiligen Sender in der Liste nach 
obern oder unten zu verschieben oder aus der Liste zu entfernen.

Internet Radio

Im Menü Internet Radio finden Sie die Optionen SKYTUNE, SUCHE und HISTORY. 

•	 Wählen Sie SKYTUNE, um aus einer großen Auswahl von Radiosendern (weltweit) zu wählen. Im Un-
termenü können Sie zwischen lokalem Filter und Filten nach Genre wählen. Sie können Ihre Region 
unter EINSTELLUNGEN (im Hauptmenü) einstellen, um zukünftig einfacher filtern zu können.

•	 Wählen Sie SEARCH, um per Namenseingabe nach einem bestimmten Sender zu suchen.

•	 Unter HISTORY sind die zuletzt aufgerufenen Sender (max. 99) gespeichert.
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Mediencenter

UPNP

Sie können Medieninhalte von UPnP-fähigen Geräten (gewöhnlicherweise Computer) zum Beispiel via Win-
dows Media Player streamen.

Mediendateien mittels Radio und UPnP finden und wiedergeben:

Sobald Sie den UPnP Server zum Teilen von Mediendateien mit dem Radio eingerichtet haben, können Sie 
diese über diese wie folgt wiedergeben.

•	 Drücken Sie MENU, um zur obersten Menüebene zu gelangen. Wählen Sie „Media Player“ -> „UPnP“.
•	 Drücken Sie SELECT und das Radio sucht nach verfügbaren UPnP Servern. Beachten Sie, dass es einige 

Sekunden dauern kann bis dis Suche erfolgt ist. Das Radio zeigt während der Suche ’[Empty]’ an und 
wird ebenfalls ’[Empty] anzeigen, wenn kein UPnP Server gefunden wird.

•	 Wählen Sie, falls es mehrere UPnP Server gibt, nach einer erfolgreichen Suche durch Drehen des Reg-
lers Ihren UPnP Server aus. 
Achtung: Das Radio wird nun zunächst nicht mit dem Server verbinden, sondern einen Verbindungs-
fehlschlag verkünden („Access denied“). Folgen Sie den unten geschilderten Schritten. Beim nächsten 
Verbindungsversuch können Sie unter UPnP zwischen den Unterkategorien „MUSIC“, „PLAYLISTS“ 
usw. wählen.

Windows PC für den Zugriff des Radios auf Audiodateien mittels UPnP Server einstellen:

•	 Falls Ihr Betriebssystem Microsoft Windows XP ist, verwenden Sie den Windows Media Player 11 
(WMP11) als UPnP (Universal Plug and Play) Medienserver. Windows Media Player 11 kann auch auf der 
Microsoft Webseite heruntergeladen und anschließend installiert werden.

•	 Nach der  Installation wird vom WMP 11 eine Medienbibliothek mit allen verfügbaren Dateien auf Ihren 
PC erstellt. Um neue Dateien zur Bibliothek hinzuzufügen wählen Sie ,Select File > Add to Library…> 
Advanced Options’, klicken auf ’Add’, wählen die gewünschten Dateien aus und bestätigen die Aus-
wahl mit einem Klick auf ’OK’.

•	 Sie müssen nun das Internetradio mit dem Windows Media Player 11 verbinden. Hierzu konfigurieren 
Sie diesen so, dass das Radio auf die Medienbibliothek zugreife kann. Um dieses durchzuführen, fah-
ren Sie so vor

•	 Ihr PC wird Sie nun fragen, ob die versuchte Verbindung zum UPnP Server zugelassen werden soll. 
Um den Zugriff auf die Mediendateien zu erlauben, klicken Sie nun auf den Tab ’Library’ des Windows 
Media Player 11 und wählen Sie zum Öffnen des ’Media Sharing’ Fenster das Symbol ’Media Sharing…’
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Wählen Sie MEDIA SHARING und markieren Sie das UNKNOWN DEVICE. Klicken Sie auf ALLOW. 
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Wecker

Wählen Sie ALARM im Hauptmenü oder drücken Sie die „ALARM“-Taste auf der Fernbedienung. Wählen Sie 
zwischen ALARM1 und ALARM2, um die unabhängig einstellbaren Weckzeiten einzustellen. Folgen Sie dem 
Alarm-Wizard, um die einzelnen Parameter zu editieren:

•	 TIME: 	 Stellen Sie die Weck-Uhrzeit ein.
•	 SOUND: 	 Wählen Sie zwischen WAKE TO RADIO (=Radio-Wecker) und WAKE TO MELODY  

		  (Standard-Melodie)
•	 REPEAT: 	 Stellen Sie die Wiederhol-Frequenz des Weckers ein.
•	 ALARM VOL.:	 Einstellung der Alarm-Lautstärke

Drücken Sie nach der Einstellung LEFT bzw.  zum Verlassen des Einstellungsmenüs und stellen Sie sich-
er, dass der Wecker aktiviert ist. In diesem Fall erscheint das Wecker-Symbol auf dem Display.

Sleep Timer

Drücken Sie mehrfach SLEEP, um den Sleep-Timer zu aktivieren und die Einschlaf-Zeit (15 bis 180 Minuten) 
einzustellen. Bei aktiviertem Sleep-Timer erscheint das Symbol  auf dem Display.

Einstellungen

Netzwerk

•	 AP hinzufügen/entfernen: 
•	 Add AP: Access-Point hinzufügen
•	 Remove AP: Accee-Point entfernen

•	 AP: [ ]	
Wählen Sie diese Option, falls Sie mehrere Router haben und zwischen diesen wechseln möchten

•	 Signal
Zeigt die Signalstärke (des vom Radio empfangenen Signals vom Router) an. Verändern Sie den 
Standort  des Geräts, falls das Signal schwächer als -70dBm ist.

•	 IP
Stellen Sie die IP des Geräts dynamisch oder statisch ein, abhängig von Ihrer Netzwerk-Konfiguration. 
Standard: DYNAMIC.

•	 DNS
Stellen Sie die DNS des Geräts dynamisch oder statisch ein, abhängig von Ihrer Netzwerk-Konfigura-
tion. Standard: DYNAMIC.

•	 WIFI Channels
Stellen Sie hier die WiFi-Channel ein (Standard: Europa & UK).
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Datum und Uhrzeit: Stellen Sie hier die Uhrzeit sowie das Datum manuell ein oder wählen Sie USE NET-
WORK TIME, damit das Gerät Datum und Uhrzeit automatisch aus dem Netzwerk bezieht.

Sprache: Deutsch / Englisch

Local Radio: Standard: Europa/UK; Ändern Sie, um über den Skytune-Weg direkten Zugriff auf die lokalen 
Sender zu haben.

Playback Setup: Wählen Sie einen Abspielmodus für UPnP-Streaming (Repeat, Repeat All, Shuffle).

DLNA Einstellungen: Benennen Sie das Radio, um es für DLNA-Server einfacher auffindbar zu machen.

Resume when Power on: Aktivieren Sie diese Funktion, damit das Gerät beim nächsten Einschalten auto-
matisch die zuletzt gehörte Frequenz aufruft.

Dimmer: Stellen Sie Modus (Normal / Energie Sparen) und Helligkeit (Bright / Dim) der Displaybeleuch-
tung ein.
Wenn das Gerät im Standby-Modus ist, können Sie die Displaybeleuchtung mit dem SELECT-Rad einstellen.

Information: Anzeige der System- und Netzwerkinformationen.

Software Update: Checken Sie von Zeit zu Zeit, ob neue Firmware-Versionen verfügbar sind. Diese werden 
in dem Fall vom Gerät heruntergeladen und installiert.

Werkszustand wiederherstellen: ACHTUNG: Alle Einstellungen und gespeicherte Sender werden ge-
löscht.

Favorite URL hinzufügen

•	 Verbinden Sie Ihren Computer mit demselben Netzwerk, in dem Ihr Radio angemeldet ist.
•	 Drücken Sie INFO auf der Fernbedienung (oder gehen Sie ins Menü -> Einstellungen -> Information) 

und öffnen Sie die IP- Info.
•	 Öffnen Sie an Ihrem Rechner einen Web-Browser (Internet-Explorer, Firefox, Chrome, Safari o.ä.) und 

geben Sie die IP-Adresse des Radios in der Adresszeile ein.
•	 In der erscheinenden Tabelle können Sie de Namen und URLs (Webadressen) von bis zu 99 Sendern 

eintragen. Diese werden mit der Favoritenliste im Radio synchronisiert.

Streaming von Mobilgeräten

Das Gerät unterstützt das Streaming via UPnP und iOS. Verbinden Sie jeweils mit iRADIO-XXXXX, um von 
Ihrem Smartphone/Tablet o.ä,. 
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Hinweise zur Entsorgung
Befindet sich die linke Abbildung (durchgestrichene Mülltonne auf Rädern) auf dem 
Produkt, gilt die Europäische Richtlinie 2002/96/EG. Diese Produkte dürfen nicht mit 
dem normalen Hausmüll entsorgt werden. Informieren Sie sich über die örtlichen Re-
gelungen zur getrennten Sammlung elektrischer und elektronischer Gerätschaften. 
Richten Sie sich nach den örtlichen Regelungen und entsorgen Sie Altgeräte nicht 
über den Hausmüll. Durch die regelkonforme Entsorgung der Altgeräte werden Um-
welt und die Gesundheit ihrer Mitmenschen vor möglichen negativen Konsequenzen 
geschützt. Materialrecycling hilft, den Verbrauch von Rohstoffen zu verringern.

Konformitätserklärung
Hersteller: CHAL-TEC GmbH, Wallstraße 16, 10179 Berlin, Deutschland.

Dieses Produkt entspricht den folgenden Europäischen Richtlinien:

1999/05/EG	 (R&TTE)
2011/65/EU 	 (RoHS)

Technische Daten

Art. no. 10009125,  10022777

Stromversorgung Netzteil (AC 230-240V-50Hz -> DC 5V)

Netzwerk IEEE802.11b/g/n

Sicherheit WEP/WPA/WPA2

Maße 164 x 98 x 98 mm (B x H x T) 

Lieferumfang Gerät. Netzteil, Fernbedienung m. Batterie, Bedienungsanleitung
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Dear Customer,

Congratulations on purchasing this product. Please read and follow these instructions, in order to avoid 
damaging the item. We do not cover any damages that may arise from improper use of the item or the 
disregard of the safety instructions.

Important Safety Advice
•	 Read all instructions before using.
•	 To protect against a fire, electric shock or personal injury, do not immerse cord, electric plugs or device 

in water or other liquids.
•	 Do not expose the appliance to extreme temperatures. The appliance shall be used in moderate cli-

mates.
•	 The use of attachments that are not recommended by the appliance manufacturer may result in fire, 

electric shock or personal injury.
•	 Do not open the unit by removing any cover parts. Do not attempt to repair the unit. Any repairs or 

servicing should be done by qualified personell only. 
•	 Only qualified persons may perform technical work on the product. The product may not be ope-

ned or changed. The components cannot be serviced by the user. The manufacturer is not responsible 
for any radio or TV interference caused by unauthorized modifications.

•	 The appliance is not a toy. Do not let children play with it. Never let children insert foreign objects into 
the appliance.

•	 Never clean the surface of the device with solvents, paint thinners, cleansers or other chemical pro-
ducts. Instead, use a soft, dry cloth or soft brush.

•	 Save these instructions.

Small objects

Keep small objects (i.e. screws, mounting material, memory cards etc.) and packaging out of the range of 
children. Do not let Children play with foil. Choking hazard!

Transporting the device

Please keep the original packaging. To gain sufficient protection of the device while shipment or transpor-
tation, make sure to put it back in its original packaging.

Cleaning the surface

Do not use any volatile liquids, detergents or the like. Use a clean dry cloth.
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Controls
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Display 1 7 PRESET
Save current station to presets

VOLUME / SELECT
Dial to change volume; 
press to enter/confirm

2 8 LEFT
Back / Previous / Left

Speaker 3 9 RIGHT
Next / Right

ON/OFF 4 10 Headphones jack

LOCAL
Search local stations 5 11 Line Out

MENU 6 12 DC socket

Remote Control:

Power Standby / On

Mute Mute on/off

0 - 9 Preset #-buttons (1-99)

Go to main menu

Mode Change modes

Alarm Set alarms

FAV+: Save to favourites

 + (1-99) Change to station (select preset number)

Local Search for local stations (in internet radio mode)

Info Station information

      Cursor buttons

Enter Confirm current selection

  FM: Previous / next station

VOL + / - Change volume

Sleep Sleep Timer



   

16

Initial Use
•	 Insert the adaptor plug into the DC socket located at the rear side of the radio. Plug the adaptor into 

a wall socket outlet. 

Caution: Use only the adaptor supplied with the radio. Connecting a power supply with a different 
rating will cause permanent damage to the radio and may be hazardous.

•	 The radio will power on and display as follow.  Choose <Yes> 
to start configuring network

 

•	 3.	 Select <Add/Remove AP> and <Add AP>:

It will start scanning the available Wi-Fi routers nearby. Choose to connect your AP and enter the  
encryption code. Press ‘Enter’ to confirm. 

Remark: The encryption codes are case sensitive to upper and lower case.

When the Wi-Fi connection is done, the display shows: 

 When this symbol appears, the radio is trying to connect to the Wi-Fi network
After the Wi-Fi network is connected, you will see the Wi-Fi signal bar here.  .

 Add/Remove AP 

AP:[  ] 

 Add AP 

Remove AP 

 
Association complete 
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Main Menu & Operation

Press <Menu> to return to the main menu or the  key on the remote controller.  You will see the item 
list:  My Favourites, Internet Radio, Media Center, Alarm, Sleep Timer, Configuration. Use the SELECT-dial to scroll 
through (rotate) and press to select the currently highlighted item.

My Favourites

•	 Press  on the RC or press and hold PRESET on the radio, to save the currently playing station to 
the favourites list.

•	 Press the   button on the remote controller or press the <Preset> button briefly on the unit to re-
call the Favorite list. You can enter the Index number to quickly scroll to the radio station you want to 
listen. e.g., On the remote controller, press 2 8 and Enter, it will scroll to the station no. 28

•	 On the Favorite list, choose the radio station you want to edit then press the right  key on the re-
mote controller.  It will enter the Edit menu with the following options: 
•	 Move down – To move down the ranking of a station
•	 Move up – To move up the ranking of a station
•	 Delete – To delete a particular station

Internet Radio

On the main menu, choose <Internet Radio> and you will find the options SKYTUNE, SEARCH and HISTORY. 

•	 Select Skytune to start enjoying thousands of radio stations over the world. You can filter your search 
by Region, Music genre and talks.  The <Local Radio> let you access quickly the stations available in 
your local area. You can change the Local Radio area under Configuration> Local radio setup.

•	 Instead of browsing the radio station list, you can access the desired station by performing search and 
input the name of the station. 

•	 The radio will memorize the stations you have listened on the radio. It can memorize up to 99 stations. 
If you have listened more than 99 stations, it will supersede the first station that you have listened. 
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Media Center

UPnP (Universal Plug and Play)
You can stream music from the Networked device which supports UPnP function.  For instance, most of the 
latest computer laptop supports UPnP, and you can stream music from Windows Media Player application 
on the computer and listen on your radio. 

•	 If your PC is running Microsoft Windows XP, then you can use Windows Media Player 11(WMP11) to act 
as your UPnP( Universal Plug and Play) media server. (For Windows 7 or above, please download the 
correspond version of Windows Media Player). Windows Media Player 11 may be downloaded from 
Microsoft’s website and install by following the instructions detailed in its installation wizard.

•	 Once installed, Windows Media Player 11 will create a library from all the media files available to it on 
your PC. To add new media files to the library, select’ File > Add to Library…> Advanced Options’, Click 
‘Add’ and choose the files you wish to add and click’ OK’.

•	 Now you need to connect your Internet radio to Windows Media Player 11 and configure it to allow the 
radio to access your media library. In order to this , you will need to do the following:
•	 Go to the main menu of the radio, select <Media Player> <UPnP>. 
•	 It will scan for all available UPnP servers . Note, this may take a few seconds for the radio to com-

plete its scan and before the scan has completed, the radio will display ‘[Empty]’. The radio will 
continue to display ‘[Empty]’ if no UPnP servers and found.

•	 After a successful scan. Select your UPnP server, by rotating the dial if there is more than one UPnP 
server, and then press SELECT (note, your radio will display’ Access Denied’ at this stage)

•	 Your PC will now prompt you that a device has attempted to connect to your UPnP server. In order to 
allow the radio to have access to the media files, you will need to click the ‘Library’ tab from Windows 
Media Player 11 and select the <Media Sharing> item to open the ‘Media Sharing’ window.

Selecting ‘Media Sharing’ for Windows Media Player11:



      

19

5. From the ‘Media Sharing’ windows , the radio will be listed as an unknown device. Click on the unknown 
device listed, then click the ‘Allow’ button and then click ‘OK’. Allowing the Radio to Connect:

Music streaming via UPnP

•	 Once the UPnP server is configure to share media files with your radio, you can start music streaming.
•	 On the main menu, select <Media Centre> and choose <UPnP>.
•	 It may take a few seconds for the radio to complete the scan for available UPnP servers. If no UPnP 

servers are found, it will show <Empty List>.
•	 After a successful scan is done, select your UPnP server
•	 The radio will show the media categories available from the UPnP server, e.g. ‘Music’, ‘Playlists’ etc.
•	 Choose the media files that you wish to play. 

You can set the mode of playback under <Configuration -> Playback setup>.

My Playlist

You can make you own playlist for the UPnP music files. Choose the song you want to add to playlist, long 
pressing the Dial until the sign   appears. The song will be added to “My playlist”. You can add up to 99 
songs to “My Playlist”.   The UPnP playlist will be erased when the radio is powered off. 

Clear My Playlist

Remove all songs in “My Playlist” to allow a new playlist to be prepared.
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Alarm Setting

Choose <Alarm> from the main menu or press the <Alarm> button on the remote controller. 
Select either Alarm 1 or Alarm 2, and choose <Turn on> to activate the Alarm. 
Follow the alarm wizard instructions to set the alarm. 

The wizard will guide you through the settings below: 

•	 Time 	 – 	 Set the time for the alarm
•	 Sound	 – 	 You can choose <Wake to Radio> or <Wake to Melody> for the alarm sound. 
			   Wake to Radio – only the preset stations can be used for the radio alarm 
			   (stations from Favorite list). Please preset your favorite station before setting 
			   the alarm. Wake to Melody - The Melody is default by system.
•	 Repeat 	 – 	 You can schedule the alarm as you desire – Everyday, Once or multiple days. 
•	 Alarm Vol	 – 	 Adjust the volume of the alarm as you like by rotating the dial. 

After the above settings are completed, press the left   button to exit and make sure the Alarm is turned on. 
You will see the Alarm icon   appeared on the display if it is activated. 

Sleep Timer

You can set the timer to let the radio go standby after certain time elapsed in the range of 15 minutes to 
180 minutes.  You can press <Sleep> button on the remote controller to set the timer. You will see the icon 

 appear on the display when the timer is set.

Configuration

Wi-Fi Network

•	 Add / Remove AP
•	 Add AP – It will scan out a list of routers available nearby 
•	 Remove AP – If you have already added a router and want to remove it, choose this option.

•	 AP: [ ]	
If you have added more than one routers on the radio and want to switch to another one, select this 
option to change

•	 Signal
This is to show the strength of the Wi-Fi Signal of the Wi-Fi router as received by the radio. Usually 
signal levels lower than -70dBm is at weaker level and if it affects the reception of your radio, you may 
need to optimize the router location or check any problem of the router itself.  

•	 IP
The IP is set <Dynamic> by default. Select to change <Fixed> IP according to your network condition. 
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•	 DNS
The DNS is set <Dynamic> by default. Select to change <Fixed> DNS according to your network con-
dition.

WIFI Channels

Not all of the Wi-Fi channels are available in every country. There may be variation between different coun-
tries. Therefore it is necessary to choose the Wi-Fi channels to ensure the Wi-Fi performs satisfactory.  
We have already set the channels according to the requirement in different countries.  Choose the country 
you are staying from the list to get the correct channel. 
The default country is set <Europe/United Kingdom>, press <Enter> on the Remote controller or push the 
<Dial> to edit the country selection. 

Date and Time: You can set Date & Time manually, choose the date and time format under this option. 
Daylight saving setting is available. 
If you want the time to be synchronized with the network time, choose <Use Network Time> from the menu. 
 If you choose to use Network time, the manual setting of Date and Time will be disabled. 

Language: English & German are available. 

Local Radio: This is to set the country of <Local Radio> that you want to access when you select <Local 
Radio>. When you press the <Local> on the remote controller or choose <Local Radio> under “Skytune”, it 
will give one-touch access the radio stations in the country that you have selected on this setting.  
The <Local Radio> is set in <Europe/United Kingdom> by default.  Select the <Europe/United Kingdom> 
and press <Enter> to change the country you want. 

Playback Setup: This is to set the mode of playback under UPnP streaming: Repeat All, Repeat Once or 
Shuffle. 

DLNA Setup: Our radio supports streaming from DLNA devices and you can rename your radio for easy 
recognition by the DLNA servers. 

Resume when Power on: You can enable this function so that the radio will connect to the last listened 
station automatically when the radio is power on. This function is off by default. 

Dimmer: You can set the display backlight level as you prefer.

There are two settings available: Mode and Level 

Mode: Normal or Power Saving
Normal – the display will stay with the same level of brightness all the time without dim down.
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Power Saving – the display will dim down after 15 seconds if no operation is made on the radio. 

Level: Bright and Dim

Bright - the display will stay at the selected level when there is operation on the radio or if the mode is 
selected in <Normal> as described above. 
Dim - the display will dim to the selected level when <Power saving> mode is selected. 
Dimmer on Standby: When the radio is on Standby, rotate the dial to adjust your prefer backlight level 
which you feel comfortable especially during night time. 

Information: View the Network and System Information of your radio. To access quickly to this informa-
tion, press the <Info> button on the remote controller. When you use your PC to manage the My favorite 
stations, you have to use the IP address and you can view this info from here. Then type in the IP address 
(Configuration>Info>Network>IP) to your PC’s browser input window

Software Update: There may be software release to upgrade features of the radio time to time. Check the 
update regularly to keep your radio up to date with the latest software.

Reset to Default You can do the reset to clear all the settings and return to default settings. Please note all 
the Station presets, Settings and configuration will be lost after you have performed the Reset. 

Add your favorite URL

You can add your favorite radio station if you know the published URL of the radio. We provide an embed-
ded server for your radio and you can manage your favorite stations anytime to add or edit the list. Follow 
the steps below to access the embedded server: 

•	 Connect your PC to the same Wi-Fi network as your radio.
•	 Locate the IP address in either way as follow:
•	 Press the <Info> button on the remote controller, choose <Network> and scroll to <IP> to view the IP 

address. On the main menu, go to Configuration>Information> Network>IP
•	 Open the web browser (we support Internet Explorer and Chrome) in your PC and type the IP address 

of the radio (e.g. 192.168.1.11).  The screen that will pop up offers a table where you can fill in names and 
URLs of radio stations, that will then be sync‘ed with your radio. You can add up to 99 radio stations.

Music Streaming from mobile devices

The radio supports playing music streams from mobile device which use UPnP or iOS streaming. When the 
radio is playing streams from the remote devices, the display will be showing „PLAYING FROM REMOTE 
SOURCE“.
The radio will be discovered as the speaker source with name <iRadio-xxxxx>. Choose it to be the speaker 
to play music, our radio will start playing the selected music from your mobile device. 
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Environment Concerns
According to the European waste regulation 2002/96/EG this symbol on the product 
or on its packaging indicates that this product may not be treated as household waste. 
Instead it should be taken to the appropriate collection point for the recycling of electrical 
and electronic equipment. By ensuring this product is disposed of correctly, you will hep 
prevent potential negative consequences for the environment and human health, which 
could otherwise be caused by inappropriate waste handling of this product. For more 
detailled information about recycling of this product, please contact your local council or 
your household waste disposial service.

Declaration of Conformity
Manufacturer: CHAL-TEC GmbH, Wallstraße 16, 10179 Berlin, Germany.

This product is conform to the following European directives:

1999/05/EC	 (R&TTE)
2011/65/EU	 (RoHS)

Technical Data

Art. no. 10009125,  10022777

Power supply AC adaptor (AC 230-240V-50Hz -> DC 5V )

Wireless network IEEE802.11b/g/n

Security Protocol WEP/WPA/WPA2

Dimensions 164 x 98 x 98 mm (L x H x D) 

Scope of delivery Device, AC adaptor, RC w/ battery, instruction manual
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Chère cliente, cher client,
Toutes nos félicitations pour l’acquisition de ce nouvel appareil. 
Veuillez lire attentivement et respecter les consignes suivantes de branchements et d’utilisation pour éviter 
d’éventuels dommages techniques. 

Avertissement
•	 L’appareil contient des éléments non accessibles à l’utilisateur. Seul un professionnel qualifié est auto-

risé à effectuer les réparations nécessaires.
•	 La référence de l’appareil se trouve sur le dessous de l’appareil.
•	 Ne pas exposer l’appareil à des gouttes ou des éclaboussures d’eau. Ne pas poser de récipient rempli 

de liquide sur l’appareil, comme par exemple un vase.
•	 Ne pas utiliser l’appareil à proximité d’une baignoire, d’un évier, d’un lavabo, d’un lavoir, sur une sur-

face humide, près d’une piscine ou dans un lieu humide ou dont l’humidité de l’air est grande.
•	 Ne pas faire tomber d’objet sur cet appareil et ne pas laisser tomber l’appareil.
•	 Ne pas poser d’objets lourds sur l’appareil.
•	 Ne pas exposer les piles à la lumière directe du soleil, à un feu ou équivalent.
•	 Utiliser uniquement les accessoires et les pièces de rechange recommandées par le fabricant.
•	 Faire contrôler l’appareil s’il est endommagé de quelque manière que ce soit, c’est-à-dire si des liqui-

des ou des objets sont tombés sur l’appareil, si l’appareil a été exposé à la pluie ou à l’humidité, s’il 
présente des dysfonctionnements ou s’il est tombé au sol. Ne pas essayer de réparer l’appareil soi-
même. Toute intervention sur l’intérieur de l’appareil entraîne l’annulation de la garantie.

Transport

Conserver l’emballage d’origine. Pour garantir une protection suffisante de l’appareil pendant son trans-
port, emballer l’appareil dans son emballage d’origine.

Nettoyage

Ne pas utiliser de liquides volatiles comme ceux des bombes insecticides. Une pression trop importante 
exercée sur la surface de l’appareil pendant le nettoyage peut l’endommager. Éviter le contact prolongé du 
caoutchouc ou du plastique avec l’appareil. Utiliser un chiffon sec.

Petits objets / pièces d’emballage 

Tenir les petits objets (par exemple les vis et le matériel d’assemblage, les cartes mémoire) et le matériel 
d’emballage hors de la portée des enfants pour éviter qu’ils ne les avalent. Empêcher les enfants de jouer 
avec les films de protection. Il existe un risque d’étouffement !
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Éléments de commande
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Affichage 1 7
PRESET
Enregistrer une station comme favorite (rester 
appuyer) ou la diffuser (appuyer brièvement

VOLUME / SELECT
Tourner pour modifier le volume ;

appuyer pour confirmer une sélection
2 8 LEFT

Menu / station précédent(e)

Haut-parleur 3 9 RIGHT
Menu / station suivant(e)

ON/OFF 4 10 Prise casque

LOCAL
Chercher une station locale 5 11 Sortie Line

MENU
Accéder au menu 6 12 Prise secteur DC

Télécommande : mettre l’appareil en marche, insérer les piles dans la télécommande et pointer la télé-
commande en direction du capteur IR situé à l’avant de l’appareil. La distance entre la télécommande et 
l’appareil ne doit pas excéder 7 m.

Power Veille/Démarrage

Mute Silencieux

0 - 9 Pavé numérique pour la sauvegarde de stations 
(0-99) (cf. annexe A pour les lettres et symboles)

Accéder au menu principal

Mode Basculer entre les fonctions de radio internet et 
le centre multimédia

Alarm Réglage de l’heure du réveil pour 2 réveils di-
stincts

FAV+ : ajouter la station en cours aux favoris

 + (1-99) Diffuser une station (sélectionner le préréglage 
avec les touches numériques)

Local Rechercher une station locale en mode radio 
internet

Info Informations sur la station

      Touches fléchées pour la navigation

Enter Confirmer le choix actuel

  Titre ou station précédent(e)/suivant(e)

VOL + / - Régler le volume

Sleep Mise en veille programmée
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Premier démarrage / Paramètres
Suivre les étapes suivantes pour connecter la radio au réseau Wi-Fi.

•	 Allumer la radio : brancher le câble d’alimentation de l’appareil à la prise secteur DC située à l’arrière 
de l’appareil et mettre l’appareil en marche.
Attention : utiliser uniquement le bloc d’alimentation fourni. Un bloc d’alimentation comprenant des 
valeurs de tension divergentes peuvent endommager l’appareil et mettre l’utilisateur en danger.

•	 L’affichage s’allume puis les indications suivantes apparais-
sent :

 

•	 À l’aide du bouton de réglage ou des touches fléchées, sélecti-
onner YES pour configurer le réseau

•	 Sélectionner ADD/REMOVE AP dans le sous-menu ADD AP (AP = « Access Point » = le routeur Wi-Fi) 

L’appareil analyse alors son environnement à la recherche de points d’accès (PA) disponibles, puis une 
liste s’affiche. Parmi cette liste, sélectionner le PA de son propre routeur et appuyer sur SELECT pour 
établir la connexion.

La dernière étape consiste à entrer le mot de passe Wi-Fi du routeur. Le taper à l’aide de VOLUME/
SELECT ou du pavé numérique de la télécommande. 

Attention : le mot de passe est « case sensitive » - respecter les majuscules et les minuscules.

•	 Une fois la connexion établie avec succès, l’affichage indique :

 Add/Remove AP 

AP:[  ] 

 Add AP 

Remove AP 

 
Association complete 
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En général, le symbole   apparaît dans le coin supérieur gauche de l’affichage pour signifier que la 
connexion est en cours. Lorsque la connexion est établie, le symbole  apparaît au même endroit sur 
l’affichage pour indiquer la qualité de la connexion.

Menu principal et fonctions

Appuyer sur la touche MENU de l’appareil ou  de la télécommande pour accéder au menu principal. 
Le menu principal affiche les options suivantes : MES FAVORIS, RADIO INTERNET, CENTRE MULTIMÉDIA, 
RÉVEIL, VEILLE PROGRAMMÉE, PARAMÈTRES. Tourner le bouton de réglage (SELECT) pour naviguer entre 
ces options puis appuyer dessus pour les sélectionner.

Mes Favoris

•	 Appuyer sur la touche   de la télécommande ou rester appuyer sur la touche PRESET de l’appareil 
pour sauvegarder la station en cours comme favori. La station ajoutée se trouvera tout en bas de la 
liste.

•	 Appuyer sur   ou PRESET (brièvement) pour accéder à la liste. Faire dérouler la liste à l’aide des 
touches fléchées ou saisir le numéro indexé de la station souhaitée à l’aide du pavé numérique de la 
télécommande. Appuyer sur SELECT pour diffuse la station choisie.

•	 Appuyer sur RIGHT ou  (télécommande) lorsqu’une des stations de la liste est en surbrillance pour 
accéder au menu des options. Ici, il est possible de faire remonter ou descendre chaque station dans 
l’ordre de la liste, voire de la retirer de la liste.

Radio internet

Le menu RADIO INTERNET permet d’accéder aux options SKYTUNE, RECHERCHE et HISTORIQUE.

•	 Sélectionner SKYTUNE pour bénéficier d’un plus grand choix de stations (à l’international). Le sous-
menu permet de choisir des filtres par localité ainsi que des filtres par genre. Il est possible de définir 
sa région dans PARAMÈTRES (dans le menu principal) pour utiliser plus facilement les filtres par la 
suite.

•	 Sélectionner SEARCH pour rechercher une station en entrant son nom.

•	 Dans HISTORIQUE, les dernières stations écoutées sont répertoriées (max. 99)
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Centre multimédia

UPNP

Il est possible de diffuser en streaming des contenus de médias d’appareils configurés pour le UPnP.(habi-
tuellement un ordinateur) via Windows Media Player. 

Trouver et diffuser des fichiers multimédia par la radio ou par UPnP :

Une fois que le serveur UPnP a été configuré pour le partage de fichiers multimédia avec la radio, il est 
possible de lire ceux-ci comme suit :

•	 Appuyer sur MENU pour accéder au menu principal. Sélectionner « Media Player » -> « UPnP ».

•	 Appuyer sur SELECT. La radio recherche les serveurs UPnP disponibles. Noter que la recherche peut 
être fructueuse après plusieurs secondes. Pendant la recherche, la radio affiche « [Empty] » et affichera 
de même [Empty] si aucun serveur UPnP est détecté.

•	 Dans le cas où plusieurs serveurs UPnP sont détectés après une recherche fructueuse, tourner le bou-
ton de réglage pour sélectionner le serveur UPnP souhaité.
Attention : la radio ne se connecte pas immédiatement au serveur, il affiche au contraire un message 
d’échec de connexion (« Access denied »). Suivre les étapes décrites ci-dessous. À la prochaine ten-
tative de connexion, il est possible de sélectionner les sous-catégories « MUSIC », « PLAYLISTS » etc. 
dans le menu UPnP. 

Paramétrer un PC fonctionnant sous Windows pour l’accès de la radio aux fichiers audio au moyen 
d’un serveur UPnP :

•	 Si le système d’exploitation de son ordinateur est Windows XP, utiliser Windows Media Player 11 
(WMP11) comme serveur multimédia UPnP (Universal Plug and Play). Windows Media Player 11 est 
également téléchargeable et installable depuis le site internet de Microsoft.

•	 Après l’installation, WMP11 crée une bibliothèque multimédia comprenant tous les fichiers disponibles 
sur le PC. Pour ajouter de nouveaux fichiers à la bibliothèque, sélectionner « Select File > Add to Lib-
rary... > Advanced Optons », cliquer sur « Add », choisir les fichiers souhaités et confirmer le choix en 
cliquant sur « OK ».

•	 Il faut à présent connecter la radio internet à Windows Media Player 11. Pour cela, la configurer de telle 
manière à ce qu’elle ait accès à la bibliothèque multimédia. Procéder ainsi :

•	 Le PC signale à l’utilisateur qu’un appareil cherche à se connecter au serveur UPnP et lui demande son auto-
risation. Pour autoriser l’accès à la bibliothèque multimédia, cliquer à présent sur l’onglet « Library » de Win-
dows Media Player 11 et sélectionner le symbole « Media Sharing... » pour ouvrir la fenêtre « Media Sharing ».  
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Sélectionner MEDIA SHARING et cliquer sur UNKNOWN DEVICE. Puis cliquer sur ALLOW. 
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Réveil

Sélectionner ALARM dans le menu principal ou appuyer sur la touche « ALARM » de la télécommande. Choi-
sir entre ALARM1 et ALARM2 pour paramétrer indépendamment deux horaires de réveil différents. Suivre 
les étapes suivantes pour paramétrer chaque réveil :

•	 TIME: 	 Régler l’heure de réveil.
•	 SOUND: 	 Choisir entre WAKE TO RADIO (réveil en radio) et WAKE TO MELODY 

		  (mélodie standard).
•	 REPEAT: 	 Définir la fréquence de répétition du réveil. 
•	 ALARM VOL.:	 Réglage du volume du réveil.

Une fois le paramétrage terminé, appuyer sur LEFT ou  pour quitter le menu des paramètres et s’assurer 
que le réveil est activé. Si tel est le cas, le symbole d’un réveil apparaît sur l’affichage.

Mise en veille programmée

Appuyer plusieurs fois sur SLEEP pour activer la mise en veille programmée et régler le temps 
d’endormissement (de 15 à 180 minutes). Une fois que la mise en veille programmée est activée, le symbole  

 apparaît sur l’affichage.

Paramètres

Réseau

•	 Ajouter/supprimer un PA :
•	 Add AP: ajouter un point d’accès
•	 Remove AP: supprimer un point d‘accès

•	 AP: [ ]	
Sélectionner cette option dans le cas où vous avez plusieurs routeurs et que vous souhaitez basculer 
de l’un à l’autre.

•	 Signal
Indique la force du signal (le signal du routeur reçu par la radio). Placer l’appareil à un autre endroit si 
la force du signal est inférieure à -70 dBm.

•	 IP
Définir l’adresse IP de l’appareil comme dynamique ou statique, en fonction de la configuration du 
réseau effectuée. Standard : dynamique.

•	 DNS
Définir le DNS de l’appareil comme dynamique ou statique, en fonction de la configuration du réseau 
effectuée. Standard : dynamique.
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•	 WIFI Channels
Configurer ici les chaînes Wi-Fi (Standard : Europe et Royaume-Uni).

Date & Time : régler manuellement l’heure et la date et sélectionner USE NETWORK TIME pour que la date 
et l’heure se synchronise automatiquement avec le réseau.

Langues : Deutsch (Allemand)  / English

Local Radio: Standard : Europe/Royaume-Uni ; modifier pour avoir un accès direct aux stations locales via 
Skytune.

Playback Setup: sélectionner un mode de lecture pour le streaming en UPnP (répétition d’un titre, répétiti-
on de tous les titres, lecture aléatoire).

DLNA Einstellungen: donner un nom à la radio pour la rendre plus facile à trouver par le serveur DLNA.

Resume when Power on: activer cette fonction pour que l’appareil diffuse automatiquement au redémar-
rage la dernière station écoutée.

Dimmer: sélectionner le mode (normal, économie d’énergie) et la luminosité (lumineux / estompé) de 
l’affichage. Lorsque l’appareil est en mode veille, il est possible de régler la luminosité de l’affichage à l’aide 
du bouton de réglage SELECT.

Information: affiche les informations relatives au système et au réseau.

Software Update: vérifier de temps en temps si de nouvelles versions de micrologiciel sont disponibles. Si 
tel est le cas, l’appareil les téléchargera et les installera.

Reset to factory default: ATTENTION : tous les paramétrages et les stations sauvegardés seront supprimés.

Ajouter un URL favori

•	 Connecter son ordinateur au même réseau que celui auquel la radio appartient.
•	 Appuyer sur la touche INFO  de la télécommande (ou se rendre dans Menu -> Paramètres -> Informa-

tion) et ouvrir les informations IP.
•	 Ouvrir un navigateur web (internet Explorer, Firefox, Chrome, Safari etc.) sur son ordinateur et entrer 

l’adresse IP de la radio dans la barre d’adresse.
•	 Dans le tableau qui apparaît, il est possible de saisir les noms et les URL (adresses Web) de 99 sta-

tions. Celles-ci seront synchronisées à la liste des stations favorites de la radio.

Streaming à partir d’appareils mobiles

L’appareil supporte un streaming via UPnP et iOS. Connecter à chaque fois avec iRADIO-XXXXX pour per-
mettre un streaming depuis un smartphone ou une tablette.
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Information sur le recyclage
Appareils électriques et électroniques usagés

Vous trouverez sur le produit l’image ci-contre (une poubelle sur roues, barrée d‘une 
croix), ce qui indique que le produit se trouve soumis à la directive européenne 
2002/96/CE. Renseignez-vous sur les dispositions en vigueur dans votre région con-
cernant la collecte séparée des appareils électriques et électroniques. Respectez-les 
et ne jetez pas les appareils usagés avec les ordures ménagères. La mise au rebut cor-
recte du produit usagé permet de préserver l’environnement et la santé. Le recyclage 
des matériaux contribue à la préservation des ressources naturelles.

Déclaration de conformité
Fabricant : Chal-Tec GmbH, Wallstraße 16, 10179 Berlin, Allemagne.

Ce produit est conforme aux directives européennes suivantes :

1999/5/CE	 (R&TTE)
2011/65/UE 	 (RoHS)

Fiche technique

Numéro d’article 10009125,  10022777

Alimentation électrique Bloc d’alimentation  (AC 230-240V-50Hz -> DC 5V)

Réseau IEEE802.11b/g/n

Sécurité WEP/WPA/WPA2

Dimensions 164 x 98 x 98 mm (L x H x P)

Contenu de l’emballage Appareil. Bloc d’alimentation, télécommande avec piles, mode 
d’emploi
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Gentile cliente,

La ringraziamo per aver acquistato il nostro dispositivo. 

La preghiamo di leggere attentamente le seguenti istruzioni e di seguirle per evitare eventuali danni. Non 
ci assumiamo alcuna responsabilità per danni derivati da una mancata osservazione delle avvertenze di 
sicurezza e da un uso improprio del dispositivo.

Avvertenze di sicurezza
•	 Il dispositivo contiene parti che non sono accessibili all‘utente: non tentare di aprirlo. Le riparazioni 

devono essere effettuate solo da personale qualificato. 
•	 Non posizionare oggetti contenenti liquidi, come vasi o annaffiatoi sul dispositivo.
•	 Non far cadere oggetti metallici sul dispositivo.
•	 Non appoggiare oggetti pesanti sul dispositivo.
•	 Utilizzare solo gli accessori approvati dal produttore.
•	 Far riparare il dispositivo solo da personale qualificato. Una riparazione è necessaria se l‘apparecchio 

è stato danneggiato in qualche modo, ovvero se sono caduti oggetti su di esso, se non funziona cor-
rettamente, oppure se è caduto. Non tentare di riparare il dispositivo da soli. Non ci assumiamo alcuna 
responsabilità per danni derivati da una manutenzione errata o da tentativi di riparazione. In questi 
casi la garanzia decade. 

•	 Non collocare fonti di fiamme vive, come ad esempio candele, sul dispositivo.
•	 Non installare il dispositivo in luoghi dove sono conservate sostanze infiammabili o esplosive.
•	 Non appendere mai il dispositivo sopra una vasca o in luoghi umidi. Tenere il dispositivo lontano da 

acqua e umidità.

Trasporto
Conservare la confezione originale. Imballare il dispositivo nella confezione originale per una protezione 
adeguata durante il trasporto.

Pulizia delle superfici esterne

Non usare liquidi volatili come insetticidi. Non strofinare le superfici troppo energicamente per non dann-
eggiarle.

Parti più piccole/imballaggio

Conservare le parti più piccole (ad es. viti, materiale di montaggio e di imballaggio) lontano dalla portata dei 
bambini, per evitare che le ingeriscano. Non lasciare che i bambini giochino con il materiale d’imballaggio. 
Pericolo di soffocamento!
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Comandi
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Display 1 7

PRESET
Memorizzare una stazione tra i preferiti (tene-
re premuto) e accedere alla stazione memoriz-
zata (premere brevemente)

VOLUME / SELECT
Ruotare la manopola per regolare il volume;
premere per confermare la selezione attuale

2 8 LEFT
Tornare al menu precedente/canale

Altoparlanti 3 9 RIGHT
Passare al menu successivo/alla stazione successiva

ON/OFF 4 10 Attacco cuffie

LOCAL
Cercare stazioni locali 5 11 Uscita line

MENU
Accedere al menu 6 12 Presa DC

Telecomando: accendere il dispositivo, inserire le batterie nel telecomando e direzionarlo verso il sensore 
IR posto sulla parte frontale del dispositivo. La distanza tra il telecomando e il dispositivo non deve supe-
rare i 7 metri. 

Power Standby/ON

Mute Disattivare l‘audio

0 - 9 Testi numerici (1-99)
(per i caratteri e i simboli vedere allegato A)

Accedere al menu principale

Mode Passare dalle funzioni della Internet Radio alle 
funzioni del Mediacenter

Alarm Impostare due sveglie

FAV+: aggiungere la stazione attuale ai preferiti

 + (1-99) Accedere alle stazioni (selezionare con i tasti 
numerici)

Local Ricerca stazioni locali in modalità Internet Ra-
dio

Info Informazioni sulle stazioni

      Tasti direzionali per navigare

Enter Confermare la selezione attuale

  Stazione/brano  precedente/successivo 

VOL + / - Regolare il volume

Sleep Timer
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Prima messa in funzione / Impostazioni
Seguire questa procedura per collegare la radio alla rete wireless.

Accendere la radio: collegare l’alimentatore alla presa DC sul retro, quindi accendere il dispositivo. 
Attenzione: Utilizzare esclusivamente l‘alimentatore incluso nella consegna. Un alimentatore con di-
versi valori di tensione può danneggiare il dispositivo e mettere in pericolo l’utente.

•	 Il display si accende e viene visualizzata la sequenza: 
 

•	 Selezionare YES con i tasti direzionali per impostare la rete:

•	 Selezionare ADD/ REMOVE AP e il sottomenu AP ADD (AP = Access Point = il proprio router wireless). 

Ora viene eseguita una scansione degli AP disponibili e infine viene visualizzato un elenco. Selezionare 
la propria rete wireless e premere SELECT per connettersi.

Nell‘ultimo passaggio viene richiesto di inserire la password del router/Wireless. Inserire la password 
tramite VOLUME/SELECT oppure tramite i tasti numerici del telecomando. 

Attenzione: la password è „case sensitive“ – prestare attenzione ai caratteri minuscoli/maiuscoli.

•	 Una volta che il collegamento è avvenuto con successo, sul display compare

 Add/Remove AP 

AP:[  ] 

 Add AP 

Remove AP 

 
Association complete 
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Sul display in alto a sinistra compare il simbolo   che indica che il dispositivo si sta connettendo. Una 
volta che la connessione è avvenuta con successo, compare il simbolo  che indica la qualità del colle-
gamento.

Menu principale e funzioni

Premere MENU sul dispositivo oppure  sul telecomando per visualizzare il menu principale: I miei prefer-
iti, Internet Radio, Media Center, Sveglia, Sleep Timer, Impostazioni. Scorrere tramite SELECT (ruotare la 
manopola) e selezionare (premere).

I miei preferiti

•	 Premere  sul telecomando oppure tenere premuto PRESET sul dispositivo per memorizzare la 
stazione corrente tra i preferiti. La stazione appena aggiunti apparirà in fondo alla lista.

•	 Premere   oppure PRESET (brevemente) per accedere all’elenco. Scorrere l’elenco con i tasti di-
rezionali oppure inserire il numero della stazione desiderata tramite i tasti numerici sul telecomando. 
Premere SELECT per accedere alla stazione in evidenza.

•	 Premere RIGHT oppure  (telecomando), mentre una stazione è in evidenza per accedere al menu 
Opzioni. Qui si ha la possibilità di spostare le stazioni presenti nella lista verso l’alto o verso il basso 
oppure di rimuoverle.

Internet Radio

Nel menu INTERNET RADIO sono presenti le opzioni SKYTUNE, SEARCH e HISTORY.

•	 Selezionare SKYTUNE per scegliere tra un’ampia selezione di stazioni radio (a livello mondiale). Nel 
sottomenu si può scegliere tra filtro locale e filtro per genere. Si può selezionare la regione tramite 
Impostazioni (nel menu principale).

•	 Selezionare SEARCH per effettuare la ricerca delle stazioni inserendo il nome.

•	 In HISTORY vengono memorizzate le ultime stazioni visitate (max. 99).
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Media Center

UPNP

È possibile riprodurre contenuti multimediali da dispositivi dotati di UPnP (di solito computer) ad esempio 
tramite Windows Media Player.

Riproduzione di file multimediali tramite la radio e l’UPnP:

Una volta installato il server UPnP per condividere file multimediali con la radio, è possibile riprodurli se-
guendo la seguente procedura:

Premere MENU per passare al livello superiore del menu. Selezionare „Media Player“ -> „UPnP“.
Premere SELECT e la radio inizia a cercare server UPnP disponibili. La ricerca dura alcuni secondi. 
Durante la ricerca appare ‚[Empty]‘. Inoltre ‚[Empty] appare anche nel caso in cui non viene trovato 
alcun server UPnP. 
Se ci sono più server UPnP,  selezionarne uno ruotando la manopola.
Nota: la radio inizialmente non si connette al server e mostra un errore di connessione („Access deni-
ed“). Seguire la procedura descritta sotto. Al tentativo successivo di connessione è possibile navigare 
tra le sottocategorie „MUSIC“, „PLAYLIST” ecc..

Impostazione di Windows per l’accesso della radio ai file audio tramite il server UPnP:

•	 Se il sistema operativo in uso è Microsoft Windows XP, utilizzare Windows Media Player 11 (WMP11) 
come media server UPnP (Universal Plug and Play). Windows Media Player 11 può anche essere scari-
cato e installato dal sito web Microsoft. 

•	 Dopo l‘installazione di WMP 11, viene creata sul PC una biblioteca multimediale con tutti i file disponi-
bili. Per aggiungere nuovi file alla biblioteca multimediale, selezionare Select File> Add to Library ...> 
Advanced Options“, cliccare su ‚Add‘, selezionare i file desiderati e confermare la selezione con ‚OK‘.

•	 A questo punto è necessario collegare l’Internet Radio a Windows Media Player 11. Configurare questo 
ultimo in maniera tale che la radio possa accedere alla biblioteca multimediale. Per fare ciò, seguire la 
procedura riportata di seguito.

•	 Il PC ora chiede se consentire al server UPnP do connettersi.
Per consentire l‘accesso ai file multimediali, cliccare su ‚Library‘ di Windows Media Player 11 e selezio-
nare ‚Media Sharing‘.
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Una colta selezionato MEDIA SHARING, cliccare su UNKOWN DEVICE (periferica sconosciuta). Infine clic-
care su ALLOW (consenti).
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Sveglia

Selezionare ALARM dal menu principale oppure premere il tasto „ALARM“ sul telecomando. Scegliere tra 
ALARM1 e ALARM2 ed impostare le due sveglie. Modificare i singoli parametri:

•	 TIME: 	 impostare l‘ora della sveglia.
•	 SOUND: 	 scegliere tra WAKE TO RADIO (= radiosveglia) e WAKE TO MELODY (Melodia standard)
•	 REPEAT: 	 impostare la frequenza di ripetizione della sveglia.
•	 ALARM VOL.:	 impostare il volume della sveglia.

In seguito premere LEFT oppure   per uscire dal menu di configurazione e assicurarsi che l’allarme sia 
attivo. In questo caso sul display viene visualizzata l’icona della sveglia.

Sleep Timer

Premere ripetutamente SLEEP per attivare il timer (da 15 a 180 minuti). Quando il timer è attivo, il simbolo  
 appare sul display.

Impostazioni

Rete

•	 Aggiungi / Rimuovi AP:
•	 Add AP: Aggiungere Access Point
•	 Remove AP: Rimuovere Access-Point

•	 AP: [ ]	
Selezionare questa opzione se si dispone di più router e si desidera passare da uno all‘altro. 

•	 Signal
Indica la potenza del segnale (il segnale radio ricevuto dal router). Cambiare la posizione del disposi-
tivo, se il segnale è inferiore a -70dBm.

•	 IP
Impostare l‘IP del dispositivo (statico o dinamico), a seconda della configurazione della rete.
Impostazione standard: DYNAMIC.

•	 DNS
Impostare il DNS del dispositivo (statico o dinamico), a seconda della  configurazione della rete. 
Impostazione standard: DYNAMIC.

•	 WIFI Channels
Impostare i canali WiFi (impostazione predefinita: Europa e Regno Unito).
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Datum und Uhrzeit: impostare l‘ora e la data manualmente oppure tramite la rete internet selezionando 
USE NETWORK TIME. 

Sprache: tedesco / inglese 

Local Radio: standard: Europa / UK; modificare per avere accesso alle stazioni locali tramite Skytune. 

Playback Setup: selezionare una modalità di riproduzione per lo streaming UPnP (Ripeti, Ripeti tutto, Shuff-
le).

DLNA Setup: la radio supporta la riproduzione da dispositivi DLNA e si può rinominare la radio in modo che 
il server DLNA possa trovarla facilmente.

Resume when Power on: abilitare questa funzione per consentire al dispositivo di accedere automatica-
mente all’ultima frequenza ascoltata.

Dimmer: impostare la modalità (risparmio energia/normale) e la luminosità (Bright/ Dim) della retroillu-
minazione.
Se l‘unità è in modalità standby, è possibile regolare la retroilluminazione con la manopola SELECT.

Information: visualizzazione delle informazioni di sistema e di rete.

Software Update: controllare ogni tanto se ci sono nuove versioni firmware disponibili che verranno sca-
ricate e installate dal dispositivo. 

Reset to factory default: ATTENZIONE: tutte le impostazioni e i canali memorizzati verranno eliminati. 

Aggiungere URL ai preferiti

•	 Collegare il computer alla stessa rete alla quale è collegata la radio.
•	 Premere INFO sul telecomando (oppure andare su Menu -> Impostazioni -> Informazioni) e aprire le 

informazioni IP.
•	 Aprire un browser sul computer (Internet Explorer, Firefox, Chrome, Safari, etc.) e inserire l‘indirizzo IP 

della radio nella barra degli indirizzi.
•	 Ora compare una tabella e qui è possibile inserire il nome e la URL (indirizzi web) di 99 stazioni. Queste 

vengono sincronizzate con la lista dei preferiti.

Riproduzione di dispositivi mobili

Il dispositivo supporta la riproduzione via UPnP e iOS. E’ possibile collegare con l’Internet Radio lo smart-
phone / il tablet o simili.
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Smaltimento
Dispositivi elettrici

Se sul prodotto è presente la figura a sinistra (il cassonetto dei rifiuti mobile sbarra-
to), si applica la direttiva europea 2002/96/CE. Questi prodotti non possono essere 
smaltiti con i rifiuti normali. Informarsi sulle disposizioni vigenti in merito alla raccolta 
separata di dispositivi elettrici ed elettronici. Non smaltire i vecchi dispositivi con i 
rifiuti domestici. Grazie al corretto smaltimento dei vecchi dispositivi, si proteggono il 
pianeta e la salute delle persone da possibili conseguenze negative. Il riciclo di mate-
riali aiuta a ridurre il consumo di materie prime.

Dichiarazione di conformità
Produttore: Chal-Tec GmbH, Wallstraße 16, 10179 Berlino, Germania.

Questo prodotto è conforme alle seguenti direttive europee:

1999/05/CE (R&TTE)
2011/65/UE (RoHS)

Dati tecnici

Numero articolo 10009125,  10022777

Alimentazione Alimentatore  (AC 230-240V-50Hz -> DC 5V)

Rete IEEE802.11b/g/n

Sicurezza WEP/WPA/WPA2

Dimensioni 164 x 98 x 98 mm (L x A x P)

Consegna Dispositivo, alimentatore, telecomando, batterie, manuale 
d’istruzioni. 
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Estimado cliente:

Le felicitamos por la adquisición de este producto. Lea atentamente el siguiente manual y siga cuidado-
samente las instrucciones de uso con el fin de evitar posibles daños. La empresa no se responsabiliza de 
los daños ocasionados por un uso indebido del producto o por haber desatendido las indicaciones de 
seguridad.

Advertencia
•	 El aparato contiene piezas no accesibles para el usuario. Las reparaciones deberán ser realizadas por 

personal técnico cualificado.
•	 La placa de especificaciones técnicas del aparato se encuentra en la parte trasera del mismo.
•	 No exponga el aparato al agua ni a salpicaduras. No coloque encima del aparato recipientes que con-

tengan líquido, como jarrones.
•	 No utilice el aparato cerca de bañeras, lavabos, fregaderos, pilones, en entornos húmedos, cerca de 

piscinas ni en lugares con mucha humedad.
•	 No deje caer objetos sobre el aparato ni deje caer el propio aparato.
•	 No coloque objetos pesados encima del aparato.
•	 No exponga las pilas a la luz del sol, al fuego ni a elementos similares.
•	 Utilice exclusivamente los accesorios recomendados por el fabricante.
•	 Será necesario reparar el aparato si se ha visto dañado de alguna manera, es decir, si se han vertido 

líquidos o han caído objetos encima, si el aparato se ha visto expuesto a la lluvia o humedad, si no 
funciona correctamente o si se ha dejado caer. No intente reparar el aparato usted mismo. Si abre la 
carcasa, se cancelará la garantía. 

Transporte del aparato

Conserve el embalaje original. Para proteger el aparato durante el transporte, introdúzcalo en su embalaje 
original.

Limpieza exterior

No utilice líquidos volátiles, como sprays insecticidas. El exterior del aparato podría dañarse si se frota 
demasiado fuerte. Evite que el aparato esté en contacto continuado con objetos de goma o plástico. Utilice 
un paño seco para limpiar el aparato.

Piezas pequeñas/partes del embalaje (bolsas de plástico, cartón, etc.)

Mantenga las piezas pequeñas (p.ej. tornillos y otro material de montaje) y las partes del embalaje fuera 
del alcance de los niños para evitar que se atraganten. No permita que los niños pequeños jueguen con los 
plásticos, pueden provocar riesgo de asfixia.
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Controles
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Display 1 7
PRESET
Guardar la emisora como favorita (mante-
ner pulsado) o acceder (pulsar)

VOLUME / SELECT
Gire el interruptor para controlar el volumen; 

pulse para confirmar la selección actual.
2 8 LEFT

Menú/emisora anterior

Altavoz 3 9 RIGHT
Menú/emisora siguiente

ON/OFF 4 10 Conexión para auriculares

LOCAL
Buscar emisoras locales 5 11 Salida Line out

MENU
Acceder al menú 6 12 Conexión al suministro eléctrico

Mando a distancia: encienda el aparato, coloque las pilas en el compartimento del mando a distancia y 
oriente este hacia el sensor IR situado en la parte delantera del aparato. La distancia entre el mando a dis-
tancia y el aparato debe ser inferior a 7 m.

Power Standby/encender

Mute Silencio

0 - 9 Teclado numérico para los espacios de memo-
ria (1-99) (consulte anexo A para letras y sím-
bolos)

Menú principal

Mode Elegir entre las funciones radio internet y re-
productor multimedia

Alarm Ajustar la hora para las dos alarmas

FAV+: añadir la emisora actual a favoritos

 + (1-99) Acceder a la emisora (seleccionar preset con el 
teclado numérico)

Local Buscar emisoras locales en el modo radio in-
ternet

Info Información sobre las emisoras

      Botones de dirección para navegar

Enter Confirmar la selección actual

  Emisora/pista anterior/siguiente

VOL + / - Controlar volumen

Sleep Temporizador de apagado automático
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Primera puesta en funcionamiento / ajustes
Siga estos pasos para conectar la radio a su red W-LAN.

•	 Encienda la radio: conecte el cable de alimentación del aparato a la conexión DC situada en su parte 
trasera y encienda el aparato.
Advertencia: utilice solamente el cable de alimentación incluido. Otro cable con una tensión distinta 
puede averiar el aparato.

•	 El display se encenderá para mostrarle el siguiente mensaje: 

•	 Seleccione YES con el interruptor o con los botones de direcci-
ón para configurar la red:

•	 Seleccione ADD/REMOVE AP y en el submenú ADD AP (AP = Access point = su router W-LAN). 

Se registrará el entorno en busca de puntos de acceso (AP) disponibles y estos aparecerán en una lista. 
Seleccione el correspondiente a su router W-LAN y pulse SELECT para conectar.

Por último, se le requerirá que introduzca la contraseña de su red W-LAN. Introdúzcala con los botones 
VOLUME/SELECT y el teclado numérico del mando a distancia. 
Advertencia: tenga en cuenta las mayúsculas y minúsculas a la hora de introducir la contraseña. 

•	 Cuando se haya establecido la conexión, aparecerá el siguiente mensaje en pantalla:

 Add/Remove AP 

AP:[  ] 

 Add AP 

Remove AP 

 
Association complete 



   

48

El aparato muestra establecimiento de la conexión con el símbolo   en la esquina superior izquierda del 
display. Si la conexión está disponible, junto al anterior símbolo aparecerá  .

Menú principal y funciones

Pulse MENU en el aparato o   en el mando a distancia para mostrar el menú principal. Este incluye los 
puntos My Favourites, Internet Radio, Media Center, Alarm, Sleep Timer, Configuration. Navegue entre las 
opciones girando el interruptor SELECT y seleccione la opción deseada pulsando el mismo botón.

Mis favoritos (My Favourites)

•	 Pulse   en el mando a distancia o mantenga pulsado PRESET para guardar la emisora actual como 
favorita. La nueva emisora se añadirá a la lista.

•	 Pulse  o PRESET para acceder a la lista. Navegue por ella con los botones de dirección o introduz-
ca el número de la emisora deseada con el teclado numérico del mando a distancia. Pulse SELECT 
para acceder a la emisora seleccionada.

•	 Pulse RIGHT o   (mando a distancia) con una emisora seleccionada para acceder al menú de op-
ciones. Tiene la posibilidad de desplazar la emisora hacia arriba o abajo en la lista o de eliminarla.

Radio internet (Internet Radio)

En el menú Radio Internet encontrará las opciones SKYTUNE, SEARCH y HISTORY.

•	 Seleccione SKYTUNE para elegir entre una gran selección de emisoras (a nivel mundial). En el sub-
menú podrá aplicar filtros locales y por género. Puede ajustar su región en la sección CONFIGURATI-
ON (menú principal) para aplicar el filtro en futuras búsquedas.

•	 Seleccione SEARCH para buscar una emisora por su nombre.

•	 En HISTORY se guardan las últimas emisoras escuchadas (máximo 99).
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Centro multimedia (Media Center)

UPNP

Puede reproducir contenido multimedia desde dispositivos compatibles con UPnP (normalmente ordena-
dor), por ejemplo por medio del reproductor de Windows Media.

Localizar y reproducir archivos multimedia vía radio y UPnP:

Una vez haya configurado el servidor UPnP para compartir archivos multimedia, puede reproducirlos sigu-
iendo estos pasos:

•	 Pulse MENU para acceder al nivel superior del menú. Seleccione “Media Player” -> “UPnP”,

•	 Pulse SELECT y la radio buscará servidores UPnP disponibles. Tenga en cuenta que la búsqueda puede 
durar unos segundos. Durante la búsqueda, en el display aparecerá “[Empty]” y mantendrá el mensaje 
en caso de no detectar ningún servidor UPnP.

•	 En caso de encontrar varios servidores, seleccione su servidor UPnP girando el interruptor.
Advertencia: la radio no estará conectada al servidor, sino que se le denegará el acceso (“Access 
denied”). Siga los pasos a continuación. En el siguiente intento de conexión podrá elegir entre las 
subcategorías “MUSIC”, “PLAYLISTS”, etc.

Configurar un PC de Windows para el acceso de la radio a archivos de audio por medio de un servidor 
UPnP:

•	 Si su sistema operativo es Microsoft Windows XP, utilice el reproductor Windows Media Player 11 
(WMP11) como servidor multimedia UPnP (Universal Plug and Play). El reproductor Windows media 11 
también puede descargarse e instalarse desde la página de Microsoft.

•	 Tras la instalación, el WPMP creará una biblioteca multimedia con todos los archivos disponibles en 
su PC. Para añadir nuevos archivos a la biblioteca, seleccione Select File > Add to Library > Advanced 
Options. Haga clic en “Add”, seleccione el archivo deseado y confirme haciendo clic en “OK”.

•	 Ahora debe conectar la radio internet con el Windows Media Player 11. Configúrelo para que la radio 
pueda acceder a la biblioteca multimedia. Siga las instrucciones.

•	 Su PC le preguntará si desea autorizar un intento de conexión a través de un servidor UPnP. Para auto-
rizar el acceso a los archivos multimedia, haga clic en la pestaña “Library” del Windows Media Player 
11 y seleccione “Media Sharing”.
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Seleccione MEDIA SHARING y marque la opción UNKNOWN DEVICE. A continuación, haga clic en ALLOW.
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Despertador (Alarm)

Seleccione ALARM en el menú principal o pulse “ALARM” en el mando a distancia. Elija entre ALARM1 y 
ALARM2 para ajustar las alarmas de manera independiente. Siga el asistente de la alarma para editar los 
siguientes parámetros:

•	 TIME: 	 ajuste la hora de alarma.
•	 SOUND: 	 elija entre WAKE TO RADIO (radio despertador) y WAKE TO MELODY (melodía estándar).
•	 REPEAT: 	 ajuste la frecuencia de repetición de la alarma.
•	 ALARM VOL.:	 ajuste el volumen de la alarma

Pulse LEFT o   para abandonar el menú de ajustes y asegúrese de que la alarma está activada. En ese 
caso, el símbolo del despertador aparecerá en el display.

Temporizador de apagado automático (Sleep Timer)

Pulse varias veces SLEEP para activar el temporizador de apagado automático y el tiempo que ha de trans-
currir (de 15 a 180 minutos). Al activar el temporizador aparecerá el símbolo  en el display.

Ajustes (Configuration)

Red (Network)

•	 Añadir/eliminar punto de acceso
•	 Add AP: añadir punto de acceso.
•	 Remove AP: eliminar punto de acceso.

•	 AP: [ ]	
Seleccione esta opción en caso de que cuente con varios router y desee cambiar entre uno u otro.

•	 Signal
Muestra la intensidad de señal (recibida por la radio del router). Reubique el aparato si la señal es más 
débil que 70 dBm

•	 IP
Ajuste la IP del aparato de como dinámica o estática, dependiendo de la configuración de su red. 
Estándar: dinámica.

•	 DNS
Ajuste el DNS del aparato como dinámico o estático, dependiendo de la configuración de su red. 
Estándar: dinámico.

•	 WIFI Channels
Ajuste el canal de WIFI (estándar: Europa y RU).
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Date & Time: ajuste la hora y la fecha de manera manual o seleccione USE NETWORK TIME para que el 
aparato detecte la hora y la fecha de la red de manera automática.

Language: alemán / inglés 

Local Radio: estándar: Europa/RU; modifíquelo para tener acceso directo a las emisoras locales.

Playback Setup: seleccione un modo de reproducción para la transmisión UPnP (Repeat, Repeat All, Shuff-
le).

DLNA Setup: ponga nombre a la radio para que el servidor DLNA pueda reconocerla más fácilmente.

Resume when Power on: active esta función para que el aparato acceda automáticamente a la última 
frecuencia escuchada la próxima vez que lo encienda.

Dimmer: configure el modo (normal/ahorro de energía) y el contraste (brillo/opaco) de la iluminación del 
display.
Con el aparato en modo standby, puede ajustar la iluminación del display con la rueda SELECT.

Information: muestra la información de la red y del sistema.

Software Update: compruebe de vez en cuando si están disponibles nuevas versiones del firmware. Podrá 
descargarlas e instalarlas desde el aparato.

Reset to factory defaults: AVISO: todos los ajustes y las emisoras memorizadas se eliminarán.

Añadir URL favoritas

•	 Conecte su ordenador a la misma red en la que está registrada su radio.
•	 Pulse INFO en el mando a distancia (o vaya a Menu > Configuration > Information) y abra IP-Info.
•	 Abra el navegador en su PC (Internet Explorer, Firefox, Chrome, Safari, etc.) e introduzca la dirección IP 

de la radio en la barra de búsqueda.
•	 En la tabla que aparece puede introducir el nombre y las URLs (direcciones web) de hasta 99 emisoras. 

Estas se sincronizarán con la radio de favoritos en la radio.

Transmisión desde dispositivos móviles

El aparato soporta la transmisión vía UPnP e iOS. Conéctelo con su Smartphone o Tablet. El nombre de la 
radio es iRADIO-XXXXX.
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Indicaciones para la retirada del aparato
Si el aparato lleva adherida la ilustración de la izquierda (el contenedor de basura 
tachado) entonces rige la normativa europea, directiva 2002/96/CE. Este producto no 
debe arrojarse a un contenedor de basura común. Infórmese sobre las leyes territori-
ales que regulan la recogida separada de aparatos eléctricos y electrónicos. Respete 
las leyes territoriales y no arroje aparatos viejos al cubo de la basura doméstica. Una 
retirada de aparatos conforme a las leyes contribuye a proteger el medio ambiente 
y a las personas a su alrededor frente a posibles consecuencias perjudiciales para la 
salud. El reciclaje ayuda a reducir el consumo de materias primas. 

Declaración de conformidad
Fabricante: Chal-Tec GmbH, Wallstraße 16, 10179, Berlín (Alemania).

Este producto cumple con las siguientes directivas europeas:

1999/05/CE 	 (R&TTE)
2011/65/UE 	 (refundición RoHS 2)

Datos técnicos

Número de artículo 10009125,  10022777

Suministro eléctrico Fuente de alimentación  (AC 230-240V-50Hz -> DC 5V)

Red IEEE802.11b/g/n

Seguridad WEP/WPA/WPA2

Dimensiones 164 x 98 x 98 mm (ancho x alto x largo)

Contenido del envío Dispositivo, cable de alimentación, mando a distancia con pilas, 
manual de instrucciones.


